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CorelDRAW® Technical Suite 2020
Introduction

Welcome! This guide is intended to support you, the administrator, in deploying
CorelDRAW ® Technical Suite 2020 to your network.

wid

:@: Are you new to network deployment? For a nontechnical introduction to
the concepts and processes discussed in this guide, please see the
companion Core/® Beginner’s Guide to Network Deployment.
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Conventions Please note the following conventions used in this guide.

Wherever you see this You'll find

italicized text A placeholder for user-specified
information, such as a path or
filename

bol d nbnospace text A reference to programming
syntax

For more information The following resources offer additional support.

For information on See the following resource
deploying Corel® software: Corel® Beginner’s Guide to Network
concepts and processes, Deployment.

general advice and best practices

Corel Corporation, or a specific Corel® website:
Corel software product www.corel.com
support for Corel software Corel® Support Services website:

www.corel.com/support

the Microsoft Windows Installer Microsoft website
(MSI) technology, which is used to
install Corel software
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Stage 1: Preparing for deployment

Before beginning the deployment, take the time to familiarize yourself with
your network and the software you want to deploy to it. Doing so can help

Highlights:
Server requirements. . . . . .. 2

your administrative duties run as smoothly as possible.
Workstation requirements. .3

In this stage Getting to know your network. . ........ ... ... ... ... 2
Getting to know the software . . ....................... 2
Setting up your network accordingly . . .. ... ... 4

Getting to know your network

Make sure to consider your network requirements for the deployment.

Administrative factors Does your organization (or do you, as administrator) have any particular
requirements for deploying and maintaining software?

Server factors Does your server have any special characteristics or constraints?
Workstation factors Do your workstations have any special characteristics or constraints?
User factors Do your workstation users have any special workflows?

For more information For general guidance on assessing your deployment needs, please refer to
“Processes: Stage 1” in the Core/® Beginner's Guide to Network Deployment.

Getting to know the software

Make sure that your server and workstations are eligible for the software.

Server requirements You can create an image of CorelDRAW Technical Suite 2020 on a server
that meets the following requirements:

* Operating system with the latest service pack and critical updates:
Windows Server 2012 R2, Windows Server 2016, Windows Server
Version 1709, or Windows Server 2019

* 3 GB of server space (for a typical installation without extra content)
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Workstation requirements

The supported server operating systems support Remote Desktop Services
(RDS) (previously known as Windows Terminal Server), but please note the
following:

* You must use the Corel DRAW Technical Suite 2020 ISO file provided
by Corel to install the software on the server.

* Corel Corporation does not provide technical support for installing third-
party software included with the product.

* When you use remote desktop virtualization and deploy Core] DRAW
Technical Suite on a server, note the following: When you access the
suite as an administrator, the security settings of Internet Explorer on
the server may not allow you to use the Welcome screen. By default,
Internet Explorer has its Enhanced Security Configuration setting
enabled. You must disable it for the Welcome screen to work normally.

For details on server permissions, see “Server setup” on page 5.

You can install CorelDRAW Technical Suite 2020 on workstations that
meet the following requirements:

* Windows 10 version 1903 and 1909, Windows 8.1, or Windows 7, in
64-bit, all with latest Updates and Service Packs. Corel DRAW Technical
Suite 2020 supports Windows 10, versions 1903 and1909 as well as
later versions to be released during the life cycle of the suite.

* OpenCL 2.2 capable video card (recommended)

* Intel Core i3/5/7/9 or AMD Ryzen 3/5/7/9, Threadripper, EPYC

* 4 GB of RAM

* 7.4 GB of hard-disk space for application files

* Multi-touch screen, mouse or tablet

* 1280 x 720 screen resolution at 100% (96 dpi), 1920 x 1080 at 150%,
and 2560 x 1440 at 200%

® CD drive optional (for box installation)
Installation from CD requires a download of up to 1.82 GB

* Microsoft Internet Explorer 11 (with the latest service pack) or later
* Microsoft .NET Framework 4.7.2 or higher
* Internet connection is required to install and authenticate CoreIDRAW

Technical Suite and access some of the included software components,
online features and content.

For details on workstation permissions, see “Workstation setup” on page 5.

Workstations that have Windows 7 must have their monitors set to True
Color (32 bit) for the software to function normally. Otherwise, the
applications may stop responding when text is added to documents.

XVL Studio Corel Edition is included and installed with Core] DRAW
Technical Suite 2020. The XVL Studio 3D CAD Corel Edition Add-On
product unlocks additional functionality for the integrated application. For
processing 3D CAD assembly data we recommend:
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* Microsoft Windows 10, Windows 8.1 or Windows 7 (64-bit editions)
with the latest updates and service pack installed

* 8 GB RAM or more

* 1280 x 800 or higher screen resolution

Software CorelDRAW Technical Suite 2020 Applications are available as an ISO file
that you can download.

Ev/ To use an ISO file, you can do one of the following:

* Mount the ISO file as a virtual drive.

* Extract the ISO file contents by using WinZip or other third-party
software.

Optionally, other content is available for download from a shared drive.
This content includes Corel® AfterShot™ HDR, images (vector files and
photos), fills, fonts, and templates.

The default installation of CorelDRAW Technical Suite offers a limited
number of fills and transparencies so it is important to download and install
the fill packs included in the Fills folder.

For more information, see “Server setup” on page 5 and “Extensions” on
page 44.

E'l Note that training videos are not available for download. You can access
short What’s New videos and Hints videos online, on the Core DRAW
YouTube channels, or from the Welcome screen in Core] DRAW, Corel
DESIGNER, and Corel PHOTO-PAINT.

For more information For important notes on installing and using the software, it’s a good idea to
review the Readme file for the software.

To access the Readme file on the installation disc

* Run the following command line (where X: is the disc drive):
X:\ ReadMes\ EN\ Readne. ht m

@ Readme files for other languages can be accessed from their respective
language folders on the DVD. Examples:
» X:\ ReadMes\ DE\ Readne. ht m
+ X'\ ReadMes\ FR\ Readne. ht ni
+ X'\ ReadMes\ JP\ Readne. ht ni

Setting up your network accordingly

After familiarizing yourself with your network and the software you want
to deploy to it, you can set up your network accordingly.
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Server setup

&

Workstation setup

Do the following:

® Make sure that you are either a local administrator or an administrator
for the domains and workgroups that you are managing.

* Create a shared network location for the server image, and make sure
that you have read/write access to that location.

If you want to make extra content (such as clipart, photos, and fills)
available to workstation users in an offline network environment, do the
following:

* Set up a shared network location, and make sure that users have access
to that location.

* You will receive a confirmation Proof of Entitlement Certificate email
containing a URL linking to a shared drive containing the extra content,
which you can download. Some of the downloadable content consists of
Zip files that you must extract to the shared network location by using
WinZip® or another compression tool.

The extracted content is 5.65 GB.

Do the following:

* Make sure that the workstations have Microsoft .NET Framework 4.7.2
or higher installed.

* Make sure that you are — and anyone else who will be installing the
software is — either a local administrator or an administrator for the
domains and workgroups that you are managing.

* Make sure that you have — and anyone else who will be installing the
software has — read access to the server-image location.

GPOs

To more easily manage the access rights of workstation users — especially
for pull-installation scenarios — you may want to consider using Group
Policy Objects (GPOs). The Corel Beginner's Guide to Network Deployment
offers basic information on GPOs. For more advanced information, please
refer to the Software Development Kit (SDK) for Group Policy, which is
available from Microsoft.
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Stage 2: Creating the server image

Highlights:

Initializing the setup . .. ... 7
Setting up the server image . 8
Finalizing the server image 11

In this stage

After preparing for deployment, you're ready to create the server image.

To create a basic image, you run a standard command line. To create a
customized image, you can modify this command line — or you can modify
certain aspects of the server image or its setup. If you want to support
multiple installation types, you can create multiple server images.

Creatingabasicimage. . ......... ... ... ... ... 7
Creating a customizedimage. . . ...................... 11
Creating multipleimages . . . ........ .. ... .. L. 11

Before creating a

Corel.com account

|fv/
45

Offline and online mode

server image

You must have a corel.com account before running the administrative
installation. If you don’t have a corel.com account, go to the corel.com
sign-in page, click Create an Account, and follow the steps.

When creating a corel.com account, validate the email that is sent to the
email address you used to create the account to avoid service disruption.

The account credentials (email address and password) used when first
signing in to create a server image are the only account credentials that will
be recognized for future sign-ins. Make note of the first credentials used.

It is recommended that you use an IT department email address as
Corel.com account name.

Customers will receive a Proof of Entitlement Certificate email. It serves as
proof of purchase and provides direct access to the software download and
serial numbers for perpetual licenses. It also contains instructions for
importing subscription licenses into the Corel.com customer account.

In some corporate environments, users must use the software in offline

mode, without access to product features that require Internet connection

and product authentication. Internet features include:

* access to videos and other online content from the Welcome screen

* in-product purchases from the Welcome screen or other access points in
the software

* QR codes

* online Help
You can restrict access to Internet features and product updates while

creating the server image. This setup will deploy the software to the
workstations in offline mode. For more information, see “Setting up the
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server image” on page 8. When you restrict access to Internet features, you
can still allow users to share files in the Corel Cloud and collaborate within
their organization with Corel DRAW.app Enterprise. For more information,
see “ALLOW _CORPORATECLOUDFEATURES” on page 17.

In online mode, workstation users have access to all Internet features as
well as product updates. Note that you can switch workstations from
offline to online mode after deployment. For more information, see
“Converting workstations from offline to online after deployment using /s”
on page 19.

Creating a basic image

In this section

Initializing the setup

74
Event logging

Limited setup Ul

&

To create a basic server image, you must initialize the setup. After setting
up the image and tweaking it as necessary, you can use it for deployment.

Initializing the setup. . . .. ... ... . 7
Setting up theserverimage. . ............ ... ... .. ..... 8
Finalizing the serverimage. . . ........ ... ... .. ........ 11

To initialize the setup for creating a server image using a limited amount of
user interface (UI), you use a command line.

The following command line lets you create a basic 64-bit server image:

X:\ x64\ Set up. exe /a

If you want to create a log file of installation events, include the / L switch
in your command line. For details on this switch, see page 15.

If you want to limit the amount of Ul encountered when creating a server
image, include the / q switch in your command line. For details on this
process, see “Limited setup UI” on page 10.

Be careful to avoid suppressing (or “silencing”) a required user-interface

field when introducing a / q switch into your command line — otherwise,

you may fail to create a valid server image. You must include the following

public properties in your command line:

* TARGETDI R="pat h" — to specify the desired location of the server
image. For best results, do not end the path with a backslash (\ ).

* SERI ALNUMBER=<Ser i al Nunber >
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Setting up the server image

Full setup Ul

If your / @ command line succeeds, the setup initializes in one of two ways:

¢ with full Ul — for the standard command line

* with limited (or no) Ul — for a command line customized to include / q

The setup Ul takes you step-by-step through the process of setting up the

server image.

Ul component

Notes

End-User License Agreement
(EULA)

To create the server image, you
must accept — on behalf of your
organization — the End-User
License Agreement. Installations
deployed from the image will not
prompt users to review the license
agreement.

Serial number, email address and
password

The Proof of Entitlement
Certificate email contains the
required serial number, which is
assigned to the corel.com account
used when creating the server
image. For more information, see
“Before creating a server image”
on page 6.

A valid serial number and your
corel.com account information,
such as email address and
password, are required to access
internet-based features and
product updates.

Image Location

Type the full (UNC) path in the
box provided, or click Change to
browse to that location. To prevent
installation problems, limit the
path to 89 characters.

Product Updates

You can choose to:

¢ automatically update the product

® check for updates and let the user
choose when to install them

* never check for updates.

You can access these options only

after entering the corel.com
account user credentials.
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Ul component Notes

Internet features This option allows workstations to
access internet-based features such
as QR codes.

You can access this option only
after entering the corel.com
account user credentials.

Welcome screen You can choose to allow
workstations to access the
Welcome screen in offline or online
mode.
When the Welcome screen is in
offline mode, users cannot
download and purchase items, nor
can they access videos and other
online content.

Allow users to sign in with their Enable this check box to allow file

corporate accounts sharing and collaboration among
corporate users. Users can sign in
to the Comments docker with their
own corporate accounts so that
they can upload files to the cloud
and collaborate on files. For more
information, see
“ALLOW_CORPORATECLOUD
FEATURES” on page 17.

To create and deploy the server image, you must use a serial number that

& begins with the prefix DE21C22 (for perpetual licenses) or DE21S22 (for
subscriptions) and has 37 characters (including dashes). If your serial
number has fewer characters, it is not a valid serial number for software
deployment.

You must be online when creating the server image so that you can
authenticate your profile. When you enter the email address and password
associated with your Corel.com account when online, a PROFILEID is
generated that allows users to be signed in automatically. For more
information, see “PROFILEID” on page 19.

If you’re offline, you can still deploy a server image without using
credentials, but workstations will not have access to internet features or
product updates. However, you can convert an offline workstation to
online. For more information, see “Converting workstations from offline to
online after deployment using /s” on page 19.

\(i)} CorelDRAWX Deployment Guide
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Limited setup Ul

&

If you want to limit the amount of user interface (UI) encountered when
creating a server image, include the / q switch in your command line. For
details on this switch, see page 16.

Be careful to avoid suppressing (or “silencing”) a required user-interface
field when introducing a / q switch into your command line — otherwise,
you may fail to create a valid server image. You must include the following
public properties in your command line:

* TARGETDI R="pat h" — to specify the desired location of the server
image. For best results, do not end the path with a backslash (\ ).
» SERI ALNUMBER=<Ser i al Nunber >

* ALLOW PRODUCTUPDATES=2 — to disable automatic updates (and in-
product messaging) on the workstations. By default, if the administrator
signs in or specifies a PROFILEID at the command line, automatic
updates are enabled for workstations installed from a server image. For
more information on the PROFILEID property, see “PROFILEID” on
page 19.

* ALLOW | NTERNETFEATURES=0 — to disable access to internet-based
features, such as QR codes.

* ALLOW CORPORATECLOUDFEATURES=1 — to allow access to
collaboration features by letting users sign in to the Comments docker
with their own Microsoft Office 365 or G Suite corporate accounts

* additional installation properties supported by the setup. For details, see
“Using public properties” on page 17.

In the following example, the administrator has signed in with account
credentials (email address and password), there is no setup UlI, the serial
number and PROFILEID properties are specified (for more information on
the PROFILEID property, see “PROFILEID” on page 19), automatic
product updates and access to internet-based features are enabled, the path

to the server image is set, and any errors are recorded in the specified log
file:

\'\ mount edl SOpat h\ Set up. exe /a /qgn

SERI ALNUVBER=<Ser i al Nunber >

PROFI LEI D=<Pr of i | el DDi gi t > ALLOW PRODUCTUPDATES=1
ALLOW | NTERNETFEATURES=1

TARGETDI R=<Pat hToAdm nl mage> /L
"C:\Logs\My_Log.txt"

In the following example, the administrator has not signed in with account
credentials (email address and password), there is no setup UlI, the serial
number is specified, automatic product updates and access to internet-
based features are disabled, the path to the server image is set, and any
errors are recorded in the specified log file:

\'\ mount edl SOpat h\ Set up. exe /a /qgn
SERI ALNUMBER=<Ser i al Nunber >
ALLOW PRODUCTUPDATES=2

ALLOW | NTERNETFEATURES=0
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TARGETDI R=<Pat hToAdm nl mage> /L
"C:\Logs\My_Log. txt"

Finalizing the server image

|fv/
45

&

Testing the image

Moving the image

This section describes recommended steps to take before deploying from
the server image.

Optionally, you can finalize the image in the following ways:

* Customize the registry settings you want to deploy (see page 40).

* Customize the setup fileset (see page 44).

To avoid deploying the software twice, you may want to check for software
updates and apply them to the image as necessary. For details, see page 27.

You may want to test your finalized image with a small subset of
workstations before rolling it out to your entire organization.

To change the location of a server image after you create it, you can copy
the image to a new location. However, after the software has been deployed
to the workstations, the image cannot be moved.

Creating a customized image

Registry keys
Setup fileset

Installation settings

If you require a more customized server image than offered by command-
line switches (see page 15) and public properties (see page 17), you may
want to consider the specialized scenarios discussed in the Appendix.

You can edit the registry settings for the server image. See page 40.

You can customize the setup fileset. See page 44.

You can customize the settings used to install the software on the
workstations. See page 46.

Creating multiple images

Product updates

If your workstations require different configurations of the software, you
can create one server image for each installation type.

When a product update becomes available, you will need to apply it to each
server image. For details on image patching, see page 27.
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Naming convention Use a naming convention that makes it easy to distinguish the server
images from one other.
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Stage 3: Installing the software

After creating the server image, you can use it to install the software on the

Highlights:
Using switches ......... 15
Using public properties . . . 17

workstations in one of two ways:

* manually, by having users “pull” the software to their own workstations

* automatically, by “pushing” the software to the workstations on their

users’ behalf

In this stage Pulling thesoftware............... ... ... ........... 13
Pushing thesoftware. . ........ ... ... ... .. .. ........ 14

Pulling the software

If users have both access to the server and administrator-level rights to their
workstations, they can install (or “pull”) the software themselves. To do
this, they run the setup from the server image.

In this section Preparing for pull installation. . . ...................... 13
Carrying out a pull installation. . . . .................... 13

Preparing for pull installation

To ensure that the pull-installation process runs as smoothly as possible,
take the time to prepare for it.

Requirements ¢ Confirm that each workstation meets the minimum requirements for the
software (see “Workstation requirements” on page 3).
* Confirm that each workstation user has read-only access to the server
image and administrator-level access to the workstation (see also
“Workstation setup” on page 5).

Recommendation Map the workstations to the server image, and set the workstations to log
in to that server location at startup. Doing so ensures that users are always
connected to the server image.

Carrying out a pull installation

Users pull the software to their workstations by running the setup from the
server image.

.w/ The degree of user interaction required by the setup depends on how you've
Y A8 . .
customized the server image and the deployment process.
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i If you prefer to restrict user customization, you may want to offer multiple
"@" server images — one per set of installation options. For details, see page 11.

To pull the software to a workstation
1 Browse to the location of the server image, and double-click Setup.exe.

2 Carry out the installation, specifying any desired options, by following
the on-screen instructions.

& To prevent installation problems, limit the installation path to
8950 characters.

Pushing the software

To “push” the software from the server image to the workstations,
you must write a command line that includes the following:

* the filename of the setup you want to use
* any desired switches, to control how the setup runs
* any desired public properties, to specify installation settings

Example: Set up. exe /g

Using this command line, you can install the software on the workstations
by using any supported push method.

When pushing a server image to workstations, the setup must be run with
administrator-level privileges.

If the Security level for this zone setting is set to High in Microsoft
Internet Explorer, no text will appear in the CorelDRAW Technical Suite
2020 installation dialog boxes. You can modify this setting in Microsoft
Internet Explorer so that text will appear by following the procedure below.

> B

To modify security settings in Internet Explorer
1 Click Tools » Internet Options.

2 Click the Security tab.

3 Click the Custom level button.

4

In the Scripting list of options, enable the Enable option for Active
scripting.

5 Click OK, and click OK again.

6 Close Microsoft Internet Explorer.

lr-/ If you plan to push the software silently, first make sure that each
workstation has Microsoft NET Framework 4.7.2 installed.
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In this section Specifying the setupfile.......... ... .. .............. 15

Using switches . . ....... . ... . . . . . 15
Using public properties .. ............ .. .. ... ... 17
Running your commandline ......................... 22

Specifying the setup file

The most important item to specify in your command line is the executable
file for the setup: the Setup.exe file on the server image you want to use:
\\ server\ pat h\ x64\ Set up. exe

* \\server\ pat h\ x64\ Set up. exe — to push the 64-bit version of
the software to 64-bit operating systems

If your path contains spaces, you must place quotation marks around it:

"\\server\path containing spaces\ Set up. exe"

Using switches

By using switches in your command line, you can control the setup process.
Listed in this section are the switches most commonly used when installing
the software.

For general information on switches, along with details on switch syntax,
please see “Switches” in the Core/® Beginner’s Guide to Network Deployment.

For a list of all command-line switches for Microsoft Windows Installer,
please see the Microsoft website.

/L Event logging
Use / L to log installation events.

Parameter What it logs

[ Status messages

w Nonfatal warnings

e All error messages

a Initiated actions

r Action-specific records

u User requests

m Error messages for out-of-memory warnings or fatal exits
0 Error messages for insufficient hard-disk space during

server installation
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Parameter What it logs

p Terminal properties

*

All of the above, in a single log file
NOTE: Alternatively to / L*, you can use / | 0g.

\ Very detailed information

The default parameters for / L are i wear no.

If you want to specify a path for the log file, use the following syntax:
/L "C\Logs\My_Log. txt"

.f/ If you do not specify a path and filename, the log file is created in the
"1 current user’s temporary (Temp) folder.

In the following example, the / L switch (with default parameters) is used
to log installation events in the specified file:

\\server\pat h\ Setup.exe /L "C \Logs\M/_Log.txt"
/q Limited setup Ul

Use / g to limit the amount of setup Ul encountered during installation.

:@: You can use / q to prevent users from entering their own registration
information, to help enforce specific installation options, or even to perform
silent installations (in which no setup Ul is visible whatsoever).

Parameter  What the user sees during installation

n No UI whatsoever. Errors are logged in a file that you
can control by using / L (see page 15). This is the default
parameter.

NOTE: Alternatively to / gn, you can use / qui et .

b Basic Ul a progress bar and a Cancel button. If the user
pushes the Cancel button, the installation is rolled back
upon confirmation.

NOTE: Alternatively to / gb, you can use / passi ve.

b! Basic UL only a progress bar. The user cannot cancel the
installation.
b+ Basic Ul a progress bar and a Cancel button. If the user

pushes the Cancel button, the installation is rolled back
(without first prompting for confirmation).

\(i)} CorelDRAWX Deployment Guide
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Parameter  What the user sees during installation

r Reduced UT: A progress bar, along with a page
containing information about the installation. The user
can cancel the installation.

Note: When run on a workstation, a command line with
this parameter automatically installs any needed
components. For example, it will install .NET 4.7.2 if the
workstation doesn’t have the required version of .NET.

f Full UI

The default parameter for / q is n.

In the following example, all setup Ul is suppressed, and any errors are
recorded in the specified log file:

\\server\path\ Setup.exe /q /L "C: \Logs\My_Log.txt"

/? Help
The / ? switch (or / hel p) displays Help for the setup.

Using public properties

By using public properties in your command line, you can specify
installation settings. Listed alphabetically in this section are the properties
most commonly used during software installation.

For general information on public properties, along with details on
property syntax, please see the Core/ Beginner's Guide to Network Deployment.
For a list of all command-line properties for Microsoft Windows Installer, please see
the Microsoft website.

ADDLOCAL Installing specific components

For details on this scenario, see the following topics in the appendix:
* “Deploying a custom set of features” on page 31

* “Deploying specific languages” on page 33

ALLOW_CORPORATECLOUD Specifying settings for collaboration features

FEATURES
The ALLOW _CORPORATECLOUDFEATURES property allows users to
sign in to the Comments docker with their own corporate accounts so that
they can collaborate on files even when Internet features are turned off. For
example, users can add comments to files, upload the files to Corel Cloud
for review, and then open the reviewed files from the cloud.

You can allow access to collaboration features by using the following
property:
ALLOW CORPORATECLOUDFEATURES=1
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If this property is not specified, collaboration features are turned on, and
users can sign in with their own corporate accounts.
You can restrict access to collaboration features by using the following
property:

ALLOW CORPORATECL OUDFEATURES=0

When collaboration features are turned off, users cannot sign in with their
own corporate accounts.

& Collaboration features can’t be turned on or off after installation.

ALLOW_INTERNETFEATURES Specifying settings for internet-based features

You can opt out of internet-based features by using the following property:
ALLOW | NTERNETFEATURES=0

You can allow access to internet-based features by using the following
property:
ALLOW | NTERNETFEATURES=1

ALLOW_PRODUCTUPDATES Specifying settings for product updates

You can check for updates and let the user choose when to install by using
the following property:

ALLOW PRODUCTUPDATES=0

You can keep the product automatically updated (and allow in-product
messaging) by using the following property:

ALLOW PRODUCTUPDATES=1

You can opt out of automatic updates (and in-product messaging) by using
the following property:

ALLOW PRODUCTUPDATES=2
& There are default settings for product updates based on whether the

administrator signs in with credentials.

* If the administrator does not sign in, ALLOW PRODUCTUPDATES=2 is
the default, and cannot be modified later.

® If the administrator enters credentials before creating the basic server
image or specifies a PROFILEID at the command line,
ALLOW PRODUCTUPDATES=1 is the default, but can be modified later.

DESKTOPSHORTCUTS Specifying settings for desktop shortcuts
You can prevent the installation of desktop shortcuts by using the following
property:
DESKTOPSHORTCUTS=0
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&

EXCLUDE_VSTA

INSTALLDIR

&

PROFILEID

You can allow the installation of desktop shortcuts by using the following
property:
DESKTOPSHORTCUTS=1

If nothing is specified, DESKTOPSHORTCUTS=1 is the default.

Opting out of installing Microsoft Visual Studio Tools for
Applications (VSTA)

You can opt out of installing VSTA by using the following property:
EXCLUDE_VSTA=1

Customizing the installation path

When deploying from the server image, use the following public property
to customize the workstation installation path of the software:

| NSTALLDI R="pat h"
This property can only be used during a workstation installation.

For best results, do not end the path with a backslash (\ ).

Converting workstations from offline to online after
deployment using /s

The PROFI LEI D property is used to push down account credentials to the
workstations and sign in all users to the account. This property enables
users to use as internet-based features, such as videos, QR codes, and online
Help as well as updates, without knowing the email address and password
associated with the Corel.com account. Users must be online to access
internet-based features and silent updates.

If the administrator deployed from the server image without signing in,
workstations can only use the software offline. After deployment,
administrators can give workstations online privileges, such as access to
internet features, using the “/ s PROFI LElI D =" switch and property.

The PROFI LEI D value is a combination of letters and numbers. To access
it, go to Your Account page on corel.com and click Product Status in Your
Products section (Support > Your Account > Product Status). The
Profile ID is in the lower-left corner of the page.

The following is an example of converting an offline workstation to online.
You cannot convert multiple workstations simultaneously. Each
workstation must be converted individually.

Exanmpl e: Setup.exe /s
PROFI LEI D=E9BBBZC091F861590331B12D63CA923
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The /s command line creates a key in the following hive directory:

HKEY _USERS\ . DEFAULT\ Sof t war e\ Cor el \ Cor el
DESI GNER\ 22. 0\ | PM_CDTS\ Pr em unfeat ur es

Profil eGui d=4797935F031C2DD2E0530D02140A2BE4

The ALLOW | NTERNETFEATURES property changes from O to 1 in the
following hive directory:

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cor el \ Cor el
DESI GNER\ 22. 0]

In addition, the WELCOVESCREENONLI NE property changes to on in the
following hive directory:

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cor el \ Cor el
DESI GNER\ 22. 0]

& The PRCFI LEI D property cannot be combined with any other properties.

This property can be used to convert workstations from offline to online
after deployment but not vice versa.

& Do not manually edit the key. Use the / s command to propetly modify the
key.

This property is not required if you have entered the email address and
password when creating the server image.

REBOOT Handling reboots

The REBOOT property is used with one of the following values to specify
how the installation process handles any required reboots.

Value What it does
Force Prompts for reboot after installation. If the
(or F) setup Ul is suppressed, the computer is

automatically rebooted after installation.
NOTE: Alternatively to REBOOT=For ce, you
can use the / f or cerest art switch.

Suppr ess Prompts for reboot during installation (if

(or S) required), but reboots automatically after
installation. If the setup UI is suppressed, all
required reboots are automatic.
NOTE: Alternatively to REBOOT=Suppr ess,
you can use the
[ pronmpt rest art switch.
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Value What it does

Real | ySuppr ess Suppresses all reboots and all reboot prompts,
(or R both during and after installation.
NOTE: Alternatively to
REBOOT=Real | ySuppr ess, you can use the
/ norestart switch.

SERIALNUMBER Specifying the serial number
The SERI ALNUMBER property is used to specify the serial number for the

installation:

SERI ALNUVBER=<Ser i al Nunber >

TARGETDIR Specifying the location of the server image

The TARGETDI R property is used to specify the desired location of the
server image.

TARGETDI R=<Pat hToAdmi nl mage>
This property can only be used during server image installations.

& For best results, do not end the path with a backslash (\ ).

Usernames cannot exceed 60 characters.

WELCOMESCREENONLINE Setting the Welcome screen in offline or online mode

This property lets you set the Welcome screen in offline or online mode.
When the Welcome screen is in offline mode, users cannot download and
purchase items. To set the Welcome screen in offline mode, use the
following syntax:

WEL COVESCREENONL | NE=o0f f

If WELCOMESCREENONLI NE is not set to of f or is any other value
different from off, the Welcome screen is in online mode. Users can
download and purchase items.

& If the administrator does not sign in and deploys the software offline, this
property is irrelevant for the workstation installations.
WEL COVESCREENONLI NE is automatically set to of f .

When the use of internet-based features
(ALLOW_INTERNETFEATURES=1) is allowed,

VEL COVESCREENONLI NE is set to on. When the use of internet-based
features (ALLOW _INTERNETFEATURES=0) is not allowed,

VEEL COVESCREENONLI NE is set to of f .
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You can change the value of WELCOVESCREENONLI NE in the persist.xml
file, stored at the root of the server image. For more information about
customizing the installation settings, see “Deploying customized
installation settings” on page 46.

Running your command line

Your command line can be used to push the software to the workstations
through any of the following:

* a batch file — see the Microsoft website for details
* a GPO — see the Group Policy SDK for details

* a third-party push technology — see the manufacturer’s
documentation for details

For many administrators, using a third-party push technology is the
preferred push method. This section offers general guidelines on using a
few such technologies. For details on using such a technology, please refer
to the manufacturer’s documentation.

SCCM At the time of this writing, Corel has verified support for Microsoft®
System Center Configuration Manager (SCCM) only insofar as its
Microsoft Systems Management Server (SMS) components.

For complete information on using SCCM, please see the Microsoft website.

SMS  For deployment to the workstations on a “per-system” basis using package
definition files (or “packages”), CorelDRAW Technical Suite 2020 supports
the use of Microsoft Systems Management Server (SMS).

You can create a package from scratch — or you can create one from the
existing SMS files included with CorelDRAW Technical Suite 2020 (in the
Administrator folder on the installation disc or the server image).

For complete information on using SMS files, please refer to your resource
kit for Microsoft Systems Management Server.

& The recommendations posted on the Microsoft website have not been
tested with Corel DRAW Technical Suite 2020 and must therefore be used
at your discretion.

Using product privileges

To take advantage of product privileges, such as silent updates, after
deployment, workstations must have internet access the first time they
launch the applications. Users can then work offline, but they won’t have
access to internet-based features.
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Users are automatically signed in to the corel.com account associated with
your volume license purchase provided you included your corel.com
account credentials (email address and password) during the creation of the
server image. This ensures that they can use their product privileges.

You can choose to remove specific workstations from Your Account page on
corel.com. To sign in workstations that you previously signed out, you must
provide account credentials. Alternatively, you can run the set up. exe /
s command with PROFI LEIl D again to restore the sign-in of signed out
workstations. For more information, see “PROFILEID” on page 19.
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Stage 4: Maintaining the installations

In this stage

An important part of administering a network is maintaining the software
installed on its workstations.

Repairing the software. . .......... ... ... ... ... .. .... 24
Modifying thesoftware . . . ...... ... ... ... ... ........ 26
Updating the software. . . ......... ... ... ... . ........ 27
Removing the software . .......... ... ... .. .. ........ 28
Troubleshooting the software . ....................... 30

Repairing the software

Repairing the software lets you install (or reinstall) missing (or corrupted)
components. You can repair a single installation of the software by using
the Windows Control Panel on that workstation, or you can repair multiple
workstation installations by using a command line.

Repairing a single installation

You can use the Windows Control Panel to repair a single installation.

To repair an installation with the Windows Control Panel

1 In the Windows Control Panel, display the list of currently installed
programs, and choose the program from the list.

2 Click Uninstall/Change.
3 Enable the Repair option, and then click Repair.

4 Follow the on-screen instructions.

Repairing multiple installations

/f

&

You can use a command line to repair multiple installations at a time.

Basic repair
Use the / f switch with the Setup.exe file on the server image:
\\server\ pat h\ Set up. exe /f

You cannot use the / f switch with public properties. For greater control
over the repair process, use the REI NSTALL and REI NSTALLMODE
properties instead of / f .
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The / f switch has the following parameters.

Parameter

What it does

p

Reinstalls missing files

o

Reinstalls missing files and files older than current version

Reinstalls missing files and files equal to or older than
current version

Reinstalls missing files and files different from current
version

Reinstalls all files

Reinstalls all required user-specific registry keys:
HKEY CURRENT USER, HKEY USERS

Reinstalls all required computer-specific registry keys:
HKEY LOCAL MACHINE, HKEY CLASSES ROOT

S

Reinstalls all existing shortcuts

\

Runs from the source files and re-caches the local package

The default parameters for / f are ouns.

REINSTALL Advanced repair

and REINSTALLMODE

For greater control over how the software is repaired, use the REI NSTALL
and REI NSTALLMODE public properties together.

Property

What it does

REI NSTALL=ALL Reinstalls all program features. If you

prefer to reinstall only specific features
(see page 31 for a list), use the following
syntax:

REI NSTALL=Feat ure

REI NSTALLMODE=t ype Specifies the type of reinstallation to

perform. The values for this property are
the same as the parameters for the / f
switch, so its default values are ouns.
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Modifying the software

Modifying the software lets you change which program features are
installed. You can modify a single installation of the software by using the
Windows Control Panel on that workstation, or you can modify multiple
workstation installations by using a command line.

Modifying a single installation

You can use the Windows Control Panel to modify a single installation.

To modify an installation with the Windows Control Panel

1 In the Windows Control Panel, display the list of currently installed
programs, and choose the program from the list.

2 Click Uninstall/Change.
3 Enable the Modify option, and then click Next.

4 Follow the instructions that appear.

Modifying multiple installations

You can use a command line to modify multiple installations at a time.

ADDLOCAL Adding features

You can use the ADDLOCAL public property to add program features:
ADDLOCAL=Feat ur e

For more than one feature, use a comma-separated list, with no spaces
between the comma and the feature name:

ADDLOCAL=Feat ur el, Feat ur e2

For a list of available features, see page 31.

REMOVE Removing features

You can use the REMOVE public property to remove a program feature:
REMOVE=Feat ure

For more than one feature, use a comma-separated list, with no spaces
between the comma and the feature name:

REMOVE=Feat ur el, Feat ur e2

For a list of available features, see page 31.
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If you want to add nearly all features and remove only a couple of features,
you can use the ADDLOCAL public property in conjunction with the
REMOVE public property. For more information, see “Deploying a custom
set of features” on page 31.

Application languages are considered as features as well. You can use the

ADDLOCAL public property and the REMOVE public property to add

and remove application languages. For more information, see “Deploying
specific languages” on page 33.

Updating the software

|fv/
45

Locating updates

Applying updates

&

Image patching

Corel periodically releases Microsoft patch (MSP) files — also known as
“patches” or “updates” — for its products. Installing updates helps keep
the software up-to-date.

In this guide, Pat ch. exe is a placeholder for the filename of the update.
The actual filename varies with each update.

Many network administrators keep their software up-to-date by
monitoring the Corel Support Services website (www.corel.com/support).
When an update is made available, these administrators download it and
carry out the patching process themselves.

In this guide, \ \ ser ver\ pat h\ Pat ch. exe is a placeholder for the
location and filename of the downloaded patch.

If you prefer to have workstation users patch the software for themselves,
you can set up the server image to enable the automatic detection of
available patches. For details, see “Setting up the server image” on page 8.

After locating and downloading an update, you can apply it to the server
image and then use the updated image to patch the installed software.

Corel will provide patches for any updates to XVL Studio Corel Edition and
XVL Player, which are included with CorelDRAW Technical Suite 2020.
However, the process of applying a XVL Studio Corel Edition patch to the
server image may differ from the process described here. For guidance, please
refer to the patch notes. For more information, see “Deploying XVL Studio
Corel Edition and XVL Player” on page 34.

You can apply an update to the server image. You must begin by extracting
the patch files to a specified location.
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Workstation patching

To extract the update files to a specified location

To extract the update files to a specified location (instead of the default
Temp folder), use the following command-line syntax:

\\server\pat h\ Pat ch. exe /extract_all "C \Extracted"

Be sure to apply all extracted update files to the server image. Applying
only some of the update files may cause the installations to function
incorrectly.

To apply the update files to the server image

Use a command line that includes the executable file for the update and the
/ a switch:

\\server\pat h\ Patch. exe /a

After updating the server image, you can deploy the update to the
workstations.

To update the workstations
Use the following command-line syntax:
\\server\ pat h\ Set up. exe REI NSTALL=ALL

By default, the REI NSTALLMODE=o0umns property is applied. For best
results, you may want to specify REI NSTALLMODE=vdm

\\server\ pat h\ Set up. exe REI NSTALL=ALL
REI NSTALLMODE=vdm

For details on REI NSTALL (and REI NSTALLMODE), see page 25.

To silently update the workstations

Use the following command line:

\\'server\ pat h\ Set up. exe RElI NSTALL=ALL
REI NSTALLMODE=vdm / gn

Removing the software

Image removal

You can remove the software from your network. Uninstalling the software
cleanly is crucial when the time comes to upgrade to a newer version.

You cannot automate the removal of a server image. Instead, you must
manually delete the image from the server.
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For best results with deleting an image, make sure that the programs to be
removed — and their associated files — are not currently in use on the
workstations.

The only way to recover a deleted server image is to re-create it by re-
running the setup.

Don’t delete the server image if there are still workstations that use the
image. Otherwise, users won’t be able to maintain and modify the
installations.

Removing the software If Remote Desktop Services (formerly known as Windows Terminal Server)
from a server re ysed so that users can run the applications from a server, make sure that
all users are logged off before you remove the software.

Workstation removal You can remove a single installation of the software by using the Windows
Control Panel on that workstation, or you can remove multiple workstation
installations by using a command line.

Removing a single installation

You can use the Windows Control Panel to remove a single installation.

To remove an installation with the Windows Control Panel

1 In the Windows Control Panel, display the list of currently installed
programs, and choose the program from the list.

2 Click Uninstall/Change.
3 Enable the Remove option.

4 If you want to remove user files (such as presets, user-created fills, and
customized files), enable the Remove user files check box.

5 Click Remove.

Repeat for Corel Graphics - Window Shell Extension and
Ghostscript GPL.

Removing multiple installations

You can use a command line to remove multiple installations at a time.

/x Basic removal

You can use the / X switch (or the / uni nst al | switch) to silently remove
the software:

\\ server\ pat h\ Set up. exe /x
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When you remove Core]lDRAW Technical Suite 2020,

XVL Studio Corel Edition and XVL Player are removed by default. If you
want to silently remove CorelDRAW Technical Suite 2020 but not

XVL Studio Corel Edition and XVL Player, use the following syntax:

\\server\pat h\ Set up. exe /x /gb DO NOT_REMOVE XVL=1

/ You must use the b parameter with the q switch(/ gb) . Using either the n
=| (/qgn) orr parameter (/qr) will not work.

"
4

REMOVE Advanced removal
and REMOVEUSERFILES

If you want more control over the removal process, use the following public

properties.

Property What it does

REMOVE=ALL Removes all features (except GPL
Ghostscript and Windows Shell
Extension)

REMOVEUSERFI LES=val ue  Specifies whether to remove user files:

* 0—no

* 1 —yes
REMOVE_GPL=1 Removes GPL Ghostscript
REMOVE_SHELLEXT=1 Removes Windows Shell Extension

For example, if you want to uninstall both GPL Ghostscript and Windows
Shell Extension, you can use the following command:

\\server\ pat h\ Set up. exe /x REMOVE_SHELLEXT=1
REMOVE_GPL=1

You can also use a MBI exec command to uninstall both GPL Ghostscript
and Windows Shell Extension.

nsi exec /i \\server\path\nsis\Setup_x64. nsi
REMOVE=ALL CHAI NER_CVD="/ b REMOVE_ SHELLEXT=1
REMOVE_GPL=1"

Troubleshooting the software

For help troubleshooting any issues with the software, please visit the
Corel® Knowledge Base (www.corel.com/knowledgebase), an online
repository of FAQs and articles.
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Appendix A: Specialized deployment scenarios

In this appendix

If you require a more specialized deployment scenario, the supplementary
topics in this appendix may be of interest to you.

Deploying a custom set of features .. .................. 31
Deploying specificlanguages. . ....................... 33
Working with MSIfiles. .. ....... ... ... ... ... .. ..., 38
Working with registry keys. . . ........ ... L. 40
Configuring content for offline availability. . ............. 42
Customizing the setup fileset. . ... ....... ... ... ... .... 44
Deploying customized installation settings . ............. 46

Deploying a custom set of features

&

When performing a basic or silent installation with the / g switch (see
page 16), you may want to use the ADDLOCAL property together with the
REMOVE property to specify a custom set of features to install. First, you
use ADDLOCAL to include all features, and then you use REMOVE to specify
which features you want to exclude.

ADDLOCAL=ALL REMOVE=Feat urel, Feat ure2
For example, if you want to install all CoreDRAW Technical Suite features

except Corel PHOTO-PAINT and Corel Capture, use the following
properties in the command line:

ADDLOCAL=ALL REMOVE=PP, Capt ure

You can specify a single feature, or a comma-separated list of components
as shown in the following examples. However, we don’t recommend this
method because it is tedious and error-prone; you may inadvertently
exclude features that you want to install.

ADDLOCAL=Feat ure
ADDLOCAL=Feat ur el, Feat ure?2

Feature names are case-sensitive.

Specifying software features by feature name

|fv/
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Corel DRAW Technical Suite 2020 components are organized into the
following child features of Mai nApp.

Some editions of the software do not include certain features listed in this
section.
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Utilities

&

Corel AfterShot 3 HDR

Local Help

User guides

When you specify a parent feature (such as Mai NApp) for programs other
than Corel DESIGNER, only program files are included. To add other child
features, you must specify them individually. And remember: Feature
names are case-sensitive.

The utilities (feature name Ut i | i ty) include the following child features.

Utility “Utility” child feature

Duplex wizard (for two-sided print jobs) DupW z

Visual Basic for Applications (VBA) VBAFi | es

Specifying Ut i | i t'y does not include its child features. You must
individually specify each desired utility.

Windows Shell Extension cannot be added or excluded by specifying the
child feature name when using the ADDLOCAL public property. To
exclude Windows Shell Extension, you must delete the following Dbm
nodes from setup.xml:

* the node that references ShellExt.msi

* the node that references 64BitKey.msi

Corel AfterShot 3 HDR is available with the extra content available for
download. You can also download Corel AfterShot 3 HDR from within ,
Corel DESIGNER, and Corel PHOTO-PAINT.

Corel AfterShot 3 HDR is a professional-grade photo editing applications
that lets you make easy corrections and enhancements to your RAW or
JPEG photos, and apply adjustments to one or thousands of photos at once
with batch processing tools. This application includes a High Dynamic
Range (HDR) Merge module that can be accessed directly from the Camera
RAW Lab in Corel PHOTO-PAINT 2020 to combine two or more photos
of the same scene that were taken with different exposure settings. Using
the HDR module, you can achieve a broader tonal range to create images
that can be breathtaking.

Local Help for Corel DESIGNER, Corel DRAW, Corel PHOTO-PAINT,
Corel Font Manager, Corel Capture, and Corel Barcode is included on the
Core]DRAW Technical Suite 2020 Applications ISO file, in MSI files. For
more information, see “Local Help” on page 40.

The Corel DESIGNER® 2020 User Guide, CoreDRAW® 2020 User
Guide and the Corel PHOTO-PAINT™ 2020 User Guide contain
comprehensive information about product features and tools. They are PDF
versions of the Help that are available online and can be accessed from the
Help Home pages (Help » Product Help).

¢
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SharePoint Integration

Corel DESIGNER and Core] DRAW give users direct access to your
organization’s document management system (DMS), such as Microsoft
SharePoint, to quickly retrieve and store documents from within Corel
DESIGNER and Core]DRAW. To use the organization’s DMS with Corel
DESIGNER and Core] DRAW, users must log in to SharePoint by using
their SharePoint credentials, not their Corel.com account credentials.

When users are working offline, they can still use the document
management feature provided they have intranet access and the SharePoint
server is installed on a local network.

Deploying specific languages

Specifying Ul modules

When performing a basic or silent installation with the / g switch (see
page 16), you may want to use the ADDLOCAL property to specify which
software languages to support. You can specify a single language:

ADDLCCAL=Feat ur el, LanguageCode
Or you can specify a comma-separated list of languages:
ADDLOCAL=Feat ur el, LanguageCodel, LanguageCode?2
Using language codes, you can specify language modules.

If you use the ADDLOCAL property in your command line to specify only
languages, you will exclude all other product features. Consider using the
ADDLOCAL property together with REMOVE to install all features and
exclude specific languages:

ADDLOCAL=ALL REMOVE=LanguageCodel, LanguageCode2

Language codes are case-sensitive.

by language code

A language module includes the software Ul By installing multiple
language modules, you can enable dynamic language switching — the ability
to change the language of the software UL

XVL Studio Corel Edition and XVL Player support only German (DE),
English (EN), French (FR), and Japanese (JP).

The following table lists the available language modules for the software,
along with their corresponding language codes.

Language module Language code

Brazilian Portuguese BR
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Language module Language code

Chinese (Simplified) Cs
Chinese (Traditional) CT
Czech (674
Dutch NL
English EN
French FR
German DE
Italian I T
Japanese JP
Polish PL
Russian RU
Spanish ES
Turkish TR

/ By default, writing tools are automatically installed for all available

e
45

languages.

Deploying XVL Studio Corel Edition and XVL Player

Updating

Removing

A typical server image of Core]DRAW Technical Suite 2020 includes the
files required to deploy XVL Studio Corel Edition and XVL Player to the
workstations.

Corel Corporation will provide patches for any updates to

XVL Studio Corel Edition and XVL Player, which are included with

Corel DRAW Technical Suite 2020. Any such patches will update the server
image of Core]DRAW Technical Suite 2020 with the latest files for

XVL Studio Corel Edition and XVL Player. The updated software can then
be deployed to the workstations by manually repairing the installed
software.

XVL Studio Corel Edition can be removed by using the
XVL Studio Corel Edition entry in the Add or remove programs dialog
box of the Windows Control Panel.
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XVL Player can be removed by using the XVL Player / Lattice3D Player
Pro (Ver. 9 or later) entry in the Add or remove programs dialog box of
the Windows Control Panel.

If you want to silently remove Core]lDRAW Technical Suite 2020 but not
XVL Studio Corel Edition and XVL Player, you must use the following
command line:

Set up. exe /x /gqb DO _NOT_REMOVE XVL=1

Understanding workspaces

Installed Corel DESIGNER

workspaces

Installed CorelDRAW
workspaces

The software installs a selection of workspaces for use in Corel DESIGNER,
Corel]DRAW, and Corel PHOTO-PAINT.

The default workspace of Corel DESIGNER 2020 is designed to provide a
more intuitive placement of tools and controls. The default settings are
included in DrawUi.xml, which is located in the

CorelDRAW Technical Suite 2020\Designer\UIConfig folder. In
addition, the following workspaces for Corel DESIGNER are installed in
CorelDRAW Technical Suite 2020\Designer\Workspace:

* lite.cdws — ideal for new users who are getting started

* Micrografx Designer.cdws — ideal for users who prefer the look and
feel of Micrografx Designer 9

* Default(TM).cdws — has a streamlined user interface (UI) that
displays only the tools and commands that users are most likely to use
when using a tablet

* Technical Illustration.cdws — optimized for users who create
technical manuals and catalogs of interactive parts

* Diagramming.cdws — features tools and a layout that are essential for
creating diagrams

* CorelDRAW X7.cdws — designed to help users transition easily from
Core]DRAW to Corel DESIGNER

* Adobe Illustrator.cdws — simulates the Adobe Illustrator workspace
by positioning the Corel DESIGNER features where you would find the
equivalent feature in Adobe Illustrator

The default workspace of CorelDRAW 2020 is designed to provide a more
intuitive placement of tools and controls. The default settings are included
in DrawUI.xml, which is located in the

CorelDRAW Technical Suite 2020\Draw\UIConfig folder.

In addition, the following workspaces for CorelDRAW are installed in
Corel DRAW Technical Suite 2020\Draw\Workspace:
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* illustration.cdws — designed for creating book cover designs,
magazine adds, storyboards, and other types of illustration

* illustrator.cdws — designed for Adobe Illustrator users

* lite.cdws — ideal for new users who are getting started

* pagelayout.cdws — optimized for users who are creating layouts for
business cards, branding materials, product packaging, or multipage
documents

* Default(TM).cdws — has a streamlined user interface (UI) that
displays only the tools and commands that users are most likely to use
when using a tablet

Installed Corel PHOTO- The default workspace of Corel PHOTO-PAINT 2020 is designed to
PAINT workspaces provide a more intuitive placement of tools and controls. The default
settings are included in PHOTO-PAINTUI xml, which is located in the
CorelDRAW Technical Suite 2020\PHOTO-PAINT\UIConfig folder.
In addition, the following workspaces for Corel PHOTO-PAINT are
installed in the Core]lDRAW Technical Suite 2020\PHOTO-
PAINT\Workspace folder:

* lite.cdws — ideal for new users who are getting started
* photoshop.cdws — designed for Adobe® Photoshop® users

* Default(TM).cdws — has a streamlined user interface (UI) that
displays only the tools and commands that users are most likely to use
when using a tablet

Custom workspaces You can customize all available workspaces by modifying the CDWS
(CorelDRAW Workspace) files. You can also create a custom workspace
from within Corel DESIGNER, CoreDRAW or Corel PHOTO-PAINT,

and you can customize the default workspace.

With CorelDRAW Technical Suite 2020, you can deploy customized
workspaces and any new workspaces you create with the installation. You
can also deploy custom default workspaces.

To deploy custom workspaces with the installation

1 Create the server image. For more information, see “Stage 2: Creating
the server image” on page 6.

2 Create the custom workspaces you want to add to the server image.

To create a custom workspace, you must start Corel DESIGNER  as a
local user. For information about how to create and export workspaces,
see the Help topic “Creating workspaces” (Help > Product Help).

3 Install CorelDRAW Technical Suite 2020 on a workstation, and log in
as a local user.

4 Copy the custom workspace files to the corresponding Workspace
folders in the server image, making sure not to delete any existing
workspace files.
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msis\Program files 64\Corel\CoreIDRAW Technical Suite
2020\Designer\Workspace

MSIs\Program files 64\Corel\Core]DRAW Technical Suite
2020\Draw\Workspace

MSIs\Program files 64\Corel\Core]DRAW Technical Suite
2020\PHOTO-PAINT\Workspace

5 Deploy the server image. For more information, see “Stage 3: Installing
the software” on page 13.

Users can access the custom workspaces after they start the applications.

To deploy custom default workspaces with the installation

The default workspace files of Corel DESIGNER, CorelDRAW and Corel
PHOTO-PAINT _default.cdws are created when the applications are
launched for the first time. You can customize the default workspaces, and
then you can deploy them similatly to the way you can deploy other
custom workspaces.

1 Install CorelDRAW Technical Suite 2020 on a workstation, and log in
as a local user.

2 Start Corel DESIGNER, Core]DRAW or Corel PHOTO-PAINT, and
customize the workspace.

3 Copy the _default.cdws file from the respective user folder.
C:\Users\[User Name\AppData\Roaming\Corel\Core]DRAW
Technical Suite 2020\Designer\Workspace
C:\Users\[User Namel\AppData\Roaming\Corel\CorelDRAW
Technical Suite 2020\Draw\Workspace

C:\Users\[User Namel\AppData\Roaming\Corel\CorelDRAW
Technical Suite 2020\PHOTO-PAINT\Workspace

4 Follow steps 3 and 4 from “To deploy custom workspaces with the
installation” on page 36.

'f'l If you want to add custom workspaces after the software has been
deployed, you must repair each workstation installation using the following
command line:

<Admi nl magePat h>\ Set up. exe REI NSTALL=ALL
REI NSTALLMODE=ouns /gn

E'/ To access the new custom workspaces, users must restart the applications
S
while holding down F8.
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Working with MSI files

Setup files

Language modules

Stored in the Setup folder, the main Microsoft Windows Installer (MSI) file
for the setup — \x64\msis\Setup_x64.msi — contains a database of main
features, registry keys, folders, and shortcuts for the software.

The server image contains a copy of the main setup MSI file — the MSI
tables within which you can modify for deployment to the workstations.

Various components of the software are stored in additional MSI files. Some
of these MSI files are required by the setup, while others represent optional
features of the software.

Besides Setup.msi, the setup requires an addition MSI file to carry out the
installation: x64\ICA_x64.msi.

The setup requires at least one language module, MSI files for which are
stored at x64\msis (64-bit) on the installation disc. XVL Studio Corel
Edition and XVL Studio 3D CAD Corel Edition support only German
(DE), English (EN), French (FR) and Japanese (JP). However, some
versions of CorelDRAW Technical Suite 2020 may include additional
language modules for the remaining components (CoreDRAW,

Corel PHOTO-PAINT, and Corel CONNECT). The following table lists
all language modules that the software may contain. The language
modules that are available vary with each edition of the software.

Language module MSI file

Brazilian Portuguese

BR_x64.msi (64-bit)

Chinese (Simplified) CS_x64.msi (64-bit)
Chinese (Traditional) CT_x064.msi (64-bit)
Czech CZ_x64.msi (64-bit)
Dutch NL_x64.msi (64-bit)
English EN_Des_x64.msi
French FR_Des_x64.msi
German DE_Des_x64.msi
Italian IT_x64.msi (64-bit)
Japanese JP_x64.msi (64-bit)
Korean KR.msi (32-bit) or KR_x64.msi (64-bit)
Polish PL_x64.msi (64-bit)
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Programs

Features

Local Help

Language module Msl file

Russian RU_x64.msi (64-bit)
Spanish ES_x64.msi (64-bit)
Turkish TR_x64.msi (64-bit)

To install the programs included with the software, the setup uses the
following MSI files at X:\x64\MSIs (64-bit) on the installation disc.

Program Msl file

Corel CAPTURE Capture_x64.msi (64-bit)

Corel DESIGNER Designer_x64.msi (64-bit)

Corel Font Manager FontManager x64.msi (64-bit)
Corel DRAW Draw_x64.msi (64-bit)

Corel PHOTO-PAINT PHOTO-PAINT x64.msi (64-bit)

To install the various components of the software, the setup uses additional
MSI files stored at Setup\x64\msis (64-bit)on the Core]l DRAW Technical
Suite 2020 DVD, the software ISO file, or in the \MSIs folder of the server

image. These files include the following.

Feature MSI file

Ghostscript general public license, Ghostscript.msi
for EPS and PostScript® import

Microsoft Visual Basic for \msis\vba\vba71.msi
Applications (VBA)

Microsoft Visual Studio Tools for ~ \msis\vsta_setup.exe
Applications (VSTA)

Windows Shell Extension ShellExt.msi and 64BitKey.msi
(64-bit)

You can exclude optional MSI files from the setup by creating a customized
server image. Excluding an MSI file prevents the corresponding feature
from being installed.

To install local Help for Corel DESIGNER, CoreDRAW/, Corel PHOTO-
PAINT, Corel Font Manager, Corel Capture, and Corel Barcode, the setup
uses the following the following MSI files stored at Setup\x64\msis (64-
bit) on the CorelDRAW Technical Suite 2020 DVD, the software ISO file,
or in the \MSIs folder of the server image:

* Documentaton_x64.msi and documentation2_x64.msi
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Local Help is installed to the following folders on the workstations, where
XX stands for the language of the Help (for example, EN for English, DE
for German, FR for French):

X:\Program Files\Corel\CorelDRAW Technical Suite
2020\Languages\XX\Help

CorelDRAW Technical Suite 2020In addition, a Help folder is installed
that contains most of the images referenced in the local Help. This folder is
installed to:

X:\Program Files\Corel\Core] DRAW Technical Suite 2020

Working with registry keys

After creating the server image, you may want to edit its registry keys for
deployment to the workstations. By doing so, you can avoid having to
manually configure the registry keys of each individual workstation
installation of the software.

Setting up dynamic language switching

Dynamic language switching allows the language of the user interface to be
changed, both during and after installation. This feature requires the
installation of multiple language modules for the software — one for each
desired user-interface language (see page 33). The selection of languages
you can implement depends on the license you have purchased.

Two sets of registry settings are required for dynamic language switching:
* workstation settings

® current user settings

Workstation settings Workstation settings affect all users. The registry setting for each
workstation is as follows:

HKEY LOCAL_MACHINE\SOFTWARE\Corel\Corel DESIGNER\
22.0\Languages

Inside this key are language keys — three-letter codes that represent the

available languages. These language keys are put in place by the setup, so
no intervention is required. Shown here (for reference only) are the three-

letter codes for the available languages for the remaining components.

Language Code
Brazilian Portuguese PTB
Chinese (Simplified) CHS
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Current user settings

Language Code

Chinese (Traditional) CHT
Czech CSY
Dutch NLD
English ENU
French FRA
German DEU
Italian ITA
Japanese JPN
Polish PLK
Russian RUS
Spanish ESN
Turkish TRK

Under each language key are the following registry settings:

* DirName — specifies the name of the folder for the language-specific
files, relative to InstallationPath\Languages

* UIName — specifies the name to show in the startup dialog box and on
the Tools » Options » Global page

The registry setting for each current user is as follows:
HKEY_ CURRENT _USER\Software\Corel\Corel DESIGNER\22.0

The UlLang setting is not initialized by the setup because the setup cannot
determine which user will run the applications. After the user has run the
application once, this setting changes to the three-letter code that
corresponds to the user-specified language key at the following location:

HKEY LOCAL MACHINE\SOFTWARE\Corel DESIGNER\22.0\
Languages

Configuring content for offline availability

Note that Corel Content Exchange — the online storage for content
accessible from earlier versions of the suite — is no longer available. Users
can download content packs from the Get More page of the Welcome
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screen when working in online mode. However, we recommend that you
make the content available to them on a network drive to facilitate their
work.

The Proof of Entitlement Certificate email will contain a URL linking to a
shared drive containing the extra content, which you can download. After
you unzip the extra content to the location you want, you can create aliases
to the various content folders from within Corel DESIGNER or

Corel DRAW. When you create aliases, a database file is created. To make it
easier for users to find and search the extra content, you must deploy this
database file to the workstations.

nrv/ The extracted content is 5.75 GB.

Internet access is required to access the download location.

To unzip the content

1 On the server that you are going to make available to all workstations,
create a main content folder and name it Corel Content.

2 Follow the content URL provided on your Proof of Entitlement
Certificate email. There are five main archive files: Applications, Fills,
Fonts, Images, and Templates. The Images folder includes clipart and
photos that are organized by theme in separate folders.

3 Extract the archive files into separate folders using a decompression tool
to the folder created in step 1.

'rv/ When all zip files have been downloaded and decompressed, you should see
the following folders:

* Applications
* Fills

* Fonts

* Images

* Templates

Once the content is available on the server, users can create aliases to the
folders so that they can access the content from within the CONNECT
Content docker, the Fill and Transparency pickers, and the New from
Template dialog box in Corel DESIGNER or . However, we recommend
that you create the aliases yourself so that it is easier for users to access extra
content.

To create aliases to the subfolders in the Images folder
1 Do any of the following:
* In Corel DESIGNER, click Window » CONNECT Content.
* In CorelDRAW, click Window P Dockers P CONNECT Content.

2 In the CONNECT Content docker, open the Choose content source
list box, and click Add new.
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3 Click Create alias.

4 In the Locate content library dialog box, browse to a subfolder in the
Images folder located on the server.

5 Click Select Folder.
Repeat steps 2 to 5 to create aliases to other subfolders in the Images

folder.

'rv/ You can create an alias to the Images folder as well. Note, however, that it
b

takes a long time to generate the thumbnails of all images. That’s why we
recommend that you create aliases to the subfolders.

To create an alias to the Fills folder

1 In Corel DESIGNER or , open the Fill picker or the Transparency picker
in the Fill or Transparency section of the Properties docker (Corel
DESIGNER: Window » Properties; Corel DRAW: Window »
Dockers » Properties).

2 In the Locate fills library dialog box, open the Choose content source
list box, and click Add new.

3 Click Create alias.

4 In the Locate fills library dialog box, browse to the Fills folder located
on the server.

5 Click Select folder.

Repeat steps 2 to 5 to create aliases to the subfolders in the Fills folder.

To create an alias to the Templates folder
1 In Corel DESIGNER or, click File » New from Template.

2 In the New from Template dialog box, open the Choose content
source list box, and click Add new.

3 Click Create alias.

4 In the Locate template library dialog box, browse to Templates folder,
located on the server.
5 Click Select folder.

Repeat steps 2 to 5 to create aliases to the subfolders in the Templates

folder.

Ev/ To share content (fills, templates, and images) created by your company
with the workstations, you can use the same method of creating aliases to
network folders from within Corel DESIGNER or Corel DRAW.

Deploy the content database file

When you create aliases, a simple database file is generated. This file is
called UserCollections.db and resides in one of the following locations:

* (Windows) AppData\Roaming\Corel\Databases\Assets V1.0
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After you deploy the content database file to the workstations, users will be
able to search and use content from the alias folders.

Extensions

Extensions, which were available for download in version 2018 and earlier,
have been integrated as regular features in the product. They no longer
need to be downloaded and extracted.

The workstations must have Microsoft .NET Framework 4.7.2 or higher
installed for these features to work.

Customizing the setup fileset

The main configuration file Setup.xml, located in the x86 or x64 folder,
lists all features included in the setup.

When you create a server image, a copy of the Setup.xml file is included. If
you want to customize the setup fileset on the server image, you must edit
the Setup.xml file to reflect your desired changes.

Understanding Setup.xml

The Setup.xml file contains four main types of nodes. With an
understanding of these four nodes, you can modify the Setup.xml file to
create a customized server image.

<Msi/> nodes Each <Msi / > node specifies a main setup file, such an executable (EXE)
file, a self-extracting ZIP file, or an MSI file that bundles (or “chains”) other
MSI files.

For example, you can exclude Ghostscript from the installation by making
the following modification.
<l--Msi productcode="Gnhostscript"
file="nmsis\CGhostscript.nsi" cmdline="ALLUSERS=1
ADDLOCAL=ALL" adm nsupport="0" condition="GPL=1"
progresstext="Str. ProgressText. Cormon" /-->

<Dbm/> nodes Each <Dbn > node specifies a component of a <Msi / > node — typically,
an MSI file. A <Dbni > node has the following structure, where GUI Dis the
associated product code, and MBI is the path and filename of the MSI file:

<Dbm product code="{QUID}" file="MsI" />

.p/ Some <Dbnt > nodes also require a condition.
S
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<Feature/> nodes

74
<Property/> nodes

Li

v ¢
@

If you want to apply an MST file to the specified MSI file, you can use the
following syntax (in cases where the MST and MSI files are in the same
folder, MST is the filename of the MST file; in cases where the MST and
MSI files are in separate folders, MST is the path and filename of the MST
file):

<Dbm productcode="{QUID}" file="MsI"
cmdl i ne=" TRANSFORMB=MST"
progresstext="Str. ProgressText. nane" />

Each <Feat ur e/ > node specifies a feature that is associated with an MSI
file. A <Feat ur e/ > node has the following format, where name is the
name of the MSI file and f eat ur e is the name of the associated feature:

<Feat ure name="Str. Feat ure. nane"
desc="Str. Feature. nane. Desc" property="feature">

Some <Feat ur e/ > nodes have subnodes.

For a list of the available features, see page 31.

Each <Pr oper t y/ > node specifies a property. A <Pr oper t y/ > node has
the following structure, where pr operty is the name of the public
property and val ue is its value:

<Property nane="property" val ue="val ue" />

For a list of available public properties, see page 17.

Creating a server image with a customized fileset

You can use Setup.xml to create a server image with a customized fileset.

To create a server image with a customized fileset
1 Copy the server image to a new location.
2 Add any desired language-module MSI files to the server image.
3 Edit Setup.xml to reflect the additions you've made to the fileset:
* Add an <Msi / > node for each new setup file.
* Add a <Dbni > node for each new language-module MSI file.
* Add the following <Pr opert y/ > node for each new language-
module MSI file, where $$ is the language:
<Property name="Incl ude. $$" val ue="1" />
4 Edit Setup.xml to reflect the removals you've made from the fileset:
* Remove the corresponding <Msi / > node for each removed setup file.
* Remove the corresponding <Dbm > node for each removed MSI file.

* Remove the corresponding <Feat ur e/ > node and subnode for each
removed MSI file.

() CorelDRAW

= TECHNICAL SUITE 2020

Deployment Guide
Appendix A: Specialized deployment scenarios 45



* Adjust any corresponding <Pr opert y/ > nodes by changing their
value.

For example, let’s say that you're creating a single-language setup from a
multi-language setup. To record the fileset changes in the Setup.xml
file, you must remove the corresponding <Dbmni > and <Feat ur e/ >
nodes for each removed language module. Next, you must set each

<Pr operty/ > node for | ncl ude. $3$ to a value of 0, where $$ is a
removed language module. The <Pr opert y/ > node for

ShowAppl i cat i onLanguageSel ect or is automatically set to a
value of 0.

Deploying customized installation settings

To modify the settings used to install the software on the workstations, you
can use the Persist.xml file stored at the root of the server image.

Each entry in Persist.xml corresponds to a public property for the software
(see page 17). The syntax of each entry is as follows:

<Property nane="property" val ue="val ue" />

By modifying the value of an existing entry in Persist.xml — or by adding
a new entry — you can customize the installation settings deployed from
that server image. This deployment method offers an excellent alternative
to creating a different server image or customizing a command line.

& You must modify Persist.xml before installing the software on the
workstations for the changes to take effect.

Example 1 You can use the following Persist.xml entry to specify that access to
internet features are enabled:

<Property name="ALLOW | NTERNETFEATURES" val ue="1" />

The administrator must either be signed in or specify a value for the
PROFILEID.

Example 2 You can use the following Persist.xml entry to specify that automatic
software updates are enabled:

<Property nanme="ALLOW PRODUCTUPDATES" val ue="1" />

By changing the value of this entry from " 1" to " 2" (and saving this
change to Persist.xml), you can disable automatic updates for the
workstation installations.

By changing the value of this entry from " 1" to " 0" (and saving this
change to Persist.xml), you can check for updates and let the user choose
when to install the update.
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ALLOW PRODUCTUPDATES must be set to " 2" if the administrator does
not sign in or specify a value for the PROFILEID, and uses the following
Persist.xml entry:

<Property name="ALLOW | NTERNETFEATURES" val ue="0" />

For more information, see “ALLOW INTERNETFEATURES” on page 18,
“ALLOW_PRODUCTUPDATES” on page 18, and “PROFILEID” on
page 19.

Example 3 You can use the following Persist.xml entry to specify the PROFILEID
and add account credentials to the server image:

<Property nanme="PROFI LEI D' val ue=" XXXXXXX" [>

Specifying a value for the PROFILEID will ensure that all workstations are
automatically signed in to the account after installation. For more
information, see “PROFILEID” on page 19.

Example 4 You can use the following Persist.xml entry to allow users to take
advantage of Welcome screen features:

<Property nane="WELCOVESCREENONLI NE" val ue="on" />
Note that the Welcome screen cannot be used without enabling internet
features and providing account credentials. For information about enabling

internet features, see “Example 1” on page 46. For information about
adding account credentials, see “Example 3” on page 47.

Example 5 You can use the following Persist.xml entry to specify the serial number
for the installation:

<Property nanme="SERI ALNUMBER' val ue="SN' />

By changing the " SN value, you can specify a different serial number for
the workstation installations.

For more information, see “SERIALNUMBER” on page 21.
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Appendix B: Authenticating the software

If you signed in by providing Corel.com account credentials when creating
the server image, all users are automatically signed in and have access to
internet-based features.

Note that access to updates and internet-based features requires software
authentication of the workstations. In this appendix, you will learn about
what information is exchanged during software authentication and what is
required for successful authentication.

In this appendix Exchanging information during authentication .. ......... 48
Requirements for authentication . ..................... 48

Exchanging information during authentication

The first time a Corel DRAW Technical Suite application is launched on a

workstation, on any given day; the following information is sent to the

Corel server that authenticates the software:

¢ Information that identifies the corel.com account, which can be either
the email address and password or the PROFILEID. For more
information about PROFILEID, see “PROFILEID” on page 19.

* Information that identifies the workstation on which the application is
launched such as computer and hardware signature and name.

* Product identifiers that specify the product family (such as CDGS for
Corel DRAW Graphics Suite or CDTS for Core] DRAW Technical Suite),
product version, language as well as the product serial number.

* Information about the license state.

The Corel server returns feature identifiers that enable online features such
as QR codes.

Requirements for authentication

For successful software authentication in a corporate network, you must
allow access to https://iws.corel.com, which is the address of the Corel
authentication server. The port number is 443, with the following specific
endpoint:

* https://iws.corel.com/ipmws/services/Subscription

To allow access to the Corel authentication server, you may need to modify
the security settings in your proxy or firewall software.
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Appendix C: FAQ

Why do | need a Corel.com
account?

My Corel.com account

credentials no longer work.

Why do | need to
authenticate the product?

Can | give users access only
to some internet features?

How can | give users access
to Corel content?

Can users on the
workstations and | use the
software in offline mode?

Where can | manage my
installations?

| deployed the software
using a server image, yet
the workstations are still
asked to sign in. Why?

This section includes answers to frequently asked questions.

A Corel.com account is required to create the server image with online
access and authenticate the product. For more information, see “Corel.com
account” on page 6.

Make sure to use the Corel.com account associated with the product. You
must type in the credentials used when you first ran the administration
installation.

To give users access to updates and internet-based features, you must
authenticate the software when you create the server image. This is done by
signing in with your Corel.com account credentials. Authentication also
takes place on the workstations but it is a silent process that doesn’t require
user sign-in. For information about what information is exchanged during
software authentication, see “Appendix B: Authenticating the software” on
page 48.

You cannot enable or disable individual internet-based features. For
example, you cannot allow users to download content packs from the
Welcome screen, but prevent them from accessing online videos or using

the QR feature.

Extra content can be downloaded from the Get More dialog box, accessible
from the Welcome screen when users work in online mode.

In addition, the Proof of Entitlement Certificate email includes a link to the
Corel content provided with the software. You must copy the content to a
network drive and give users access to this drive. In addition, you need to
create aliases to the content folders to make content such as fills and
transparencies accessible from within the software. For more information,
see “Configuring content for offline availability” on page 42.

Yes, it is possible if you have a license with a long serial number (37
characters) and use this serial number to create a server image. For more
information, see “Setting up the server image” on page 8.

You can manage your installations from the Corel.com account that was
used to sign in and create the server image. For example, you can remove
specific workstations from Your Account page.

The sign-in may be required for one of the following reasons:

* You signed in with your Corel.com account credentials when you created
the server image to deploy the software in online mode. However, the
workstation was not online when the user first launched the product. In
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this case, the workstation attempts to access iws.corel.com, the Corel
authentication server, to authenticate the software.

* You have removed the workstation from Your Account page of your
corel.com account. When a workstation is removed, it cannot be signed-
in automatically. The user of the workstation must sign in once.

* If the workstation is offline for a long time after the sign-in, software
authentication is required to make sure that product entitlements have
not changed or expired.

\(a)] CorelDRAWX Deployment Guide
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